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Abstract. Adidharma MA, Supriatna, Takarina ND. 2023. The impact of nickel mining on vegetation index in Molawe Sub-district, 

North Konawe District, Southeast Sulawesi, Indonesia. Biodiversitas 24: 4581-4588. Nickel mining activities in Molawe Sub-district, 

North Konawe District, Southeast Sulawesi, Indonesia have modified the land cover structure over time due to increased mining 

exploitation zones. This study intends to assess changes in land cover in the Molawe Sub-district, particularly around mining regions. 

The NDVI index was applied to Landsat 7 ETM+ satellite imagery data in 2001 to identify land cover conditions before mining 

activities, then to Landsat 8 OLI imagery data in 2015 and 2020 to identify land cover after mining activities. These data are then used 

to compute annual changes in the extent of each land cover. The NDVI classification produces four land cover types: non-vegetation, 

open soil, sparse vegetation, and moderate vegetation. The study shows that non-vegetation and open ground cover types experienced a 

significant increase in area from 2001 to 2015 and from 2015 to 2020. Meanwhile, sparse vegetation forest cover experienced a 

reduction in area from 2001 to 2015 and 2015 to 2020. In contrast to sparse vegetation, the moderate vegetation cover is experiencing a 

minor increase in area. Based on these results, relevant policymakers need to formulate policies to mitigate environmental impacts that 

may arise in the future. 
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INTRODUCTION 

The mining industry is an essential sector in the 

Indonesian economy, contributing 11% of Indonesia's GDP 

in 2020 (Laksana 2022). Based on data from the Indonesian 

Chamber of Commerce and Industry (2022), Indonesia's 

five largest types of mining products are nickel, gold and 

silver, bauxite, copper concentrate, copper ore, and tin. 

Nickel is the most produced mining product, amounting to 

35.5 million metric tons. According to data from the 

Ministry of Energy and Mineral Resources for 2020, nickel 

mining activities in Indonesia are spread across several 

provinces, the largest in Southeast Sulawesi Province. 

Southeast Sulawesi has quite large nickel reserves. Based 

on data from the ESDM Office of Southeast Sulawesi 

Province, nickel reserves in Southeast Sulawesi reach 97 

billion tons with a distribution area of 480 thousand 

hectares (Southeast Sulawesi Government 2021). 

Because of the enormous nickel reserves in Southeast 

Sulawesi, nickel is the principal mining commodity in the 

province (Prasetyo et al. 2015), with production in 2018 

totaling 16,926,763 tonnes and expected to reach 

22,531,686 tonnes by 2020. The 143 nickel mining firms in 

Sulawesi Southeast contributed to the total nickel 

production. Based on data from the Central Bureau of 

Statistics for Southeast Sulawesi Province, in 2022, North 

Konawe District has the largest nickel mining activity in 

Southeast Sulawesi, where as many as 70 nickel companies 

operate in this area. Its mining activities are spread over 

several sub-districts, where eight nickel mining companies 

operate in the Molawe Sub-district. The magnitude of 

mining activities in this area contributes to employment 

and local regional income (Kurakova and Ponomarenko 

2021). However, on the other hand, it is a driving factor for 

deforestation (Mbaya 2013; Kramer et al. 2023) due to the 

expansion of the exploited area from time to time. These 

deforestation activities cause several negative impacts, 

such as increasing the average air temperature (Prevedello 

et al. 2019; Wolff et al. 2021) related to global warming 

(Lawrence et al. 2022), reducing the organic carbon content 

in the soil and significantly causing the soil more unstable 

(Amoakwah et al. 2022). In mining sites, especially those 

that use open-pit mining techniques, landslides are a 

calamity that is very likely to happen. Due to the easily 

destroyed and unstable rock and soil conditions in the 

mining area, open-pit mining locations will have a very 

high level of erosion susceptibility. The geographical 

position in steep mountains (Momon et al. 2021) and the 

presence of natural variables, such as rainfall (Chen et al. 

2023), can worsen the instability of this soil structure. 

Based on these effects, land cover monitoring is required to 

gather data and serve as a resource when developing 

policies to safeguard and conserve coastal and forest areas 

(Romijn et al. 2015). 
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Normalized Difference Vegetation Index (NDVI) is an 

index commonly used to measure the level of greenness 

and density of vegetation to assess the temporal changes of 

vegetation (Gandhi et al. 2015; Huang et al. 2020). Besides 

providing an overview of the temporal dynamics of 

terrestrial ecosystems, NDVI can also provide information 

for ecosystem use and protection (Essaadia et al. 2022). 

According to Wang (2016) and Gao et al. (2022), human 

activity significantly impacts NDVI since different levels 

of human activity in land use might increase or decrease in 

NDVI. Studies have shown that using the NDVI to track 

land cover change yields accuracy ranging from 88% to 

96%, according to research (Madasa et al. 2021). The 

spatial model's output from this study is anticipated to 

guide managing land and minimizing forest damage from 

nickel mining. According to the results, it is vital to use 

NDVI analysis to identify changes in land cover caused by 

mining activities. The study is anticipated to offer 

recommendations and feedback on forest regeneration 

techniques in nickel mining regions in the Molawe Sub-

district 

MATERIALS AND METHODS 

Study area 

The research area is the Molawe Sub-district, North 

Konawe District, Southeast Sulawesi Province, Indonesia 

(Figure 1). The Molawe Sub-district area stretches from 

north to south between 02o97' and 03o86' South and 

stretches from west to east between 121o49' and 122o49' 

East. Molawe Sub-district has an open nickel mining area 

in several village areas with mountainous, undulating, and 

hilly topography surrounding the lowlands (Central Bureau 

of Statistics for North Konawe Regency 2022). In addition, 

the Lasolo River Estuary is the largest river in North 

Konawe District. The Area of Interest (AOI) for observing 

land cover is limited to four areas: Tapunggaya, Tapuemea, 

Mandiodo, and Mowundo Villages. AOI is limited by 

digitizing to form polygons in Google Earth Pro Software 

(Atiqah et al. 2020). The restricted area is a mining area in 

the Molawe Sub-district area. The created polygons are 

then exported in KML format. The KML file is then 

imported into the ArcMap 10.8 software and converted into 

layers. The AOI layer is then re-exported and saved in the 

Shapefile (SHP). The AOI SHP file will later be used 

further in image cropping. 

Procedures 

Remote sensing data collection 

The image data used in this study are level 2 Landsat 7 

ETM+ and Landsat 8 OLI image data, which temporally 

represent periods prior to mining (2001) and following 

mining (2015 & 2020). Image data was downloaded from 

the website https://earthexplorer.usgs.gov/. Details of the 

remote sensing data used in this study are presented in 

Table 1. Landsat level 2 image data is selected based on the 

availability of image data that already contains surface 

reflectance data (Fawzi and Husna 2019; USGS 2022). 

Thus, there is no need for radiometric and atmospheric 

correction of the image. The image is selected based on the 

acquisition time criteria and cloud cover, which is a 

maximum of 20%. 

 

 
Table 1. Satellite image data used in this research 

 

Imagery File Name 
Acquisition 

Date 

LE07_L2SP_113062_20010121_20200917_02_T1 21 Jan 2001 

LC08_L2SP_113062_20151120_20200908_02_T1 20 Nov 2015 

LC08_L2SP_113062_20200829_20200906_02_T1 29 Aug 2020 

 

 

 

  
Figure 1. Location of AOI in Molawe Sub-district, North Konawe District, Southeast Sulawesi Province, Indonesia 

https://earthexplorer.usgs.gov/
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NDVI classification 

Land cover change analysis was conducted using 

Normalized Difference Vegetation Index (NDVI) analysis. 

A high NDVI index value will indicate forest, agricultural, 

and plantation areas, while a low value indicates vacant 

land or land without crops (Mohajane et al. 2017). NDVI 

classification is made by selecting well-defined class 

intervals with a specific color for each class (Essaadia et al. 

2022). The NDVI formula is as follows: 

 

...................................................(1) 

NDVI analysis can be performed using ArcMap 10.8 on 

the Raster Calculator tool. The bands used are bands 3 

(red) and 4 (NIR) on Landsat 7 ETM+ and bands 4 (red) 

and 5 (NIR) on Landsat 8 OLI (Gessesse and Melesse 

2019; Gutman et al. 2021). The results of the NDVI 

analysis of the images are then exported in TIFF format. 

The TIFF file is then imported into ArcMap 10.8 software 

for further analysis. The resulting NDVI image imported to 

ArcMap 10.8 is cropped according to the AOI area 

previously created using the Arc Toolbox > Data 

Management Tool > Raster > Raster Processing > Clip. 

After the image cropping process, the NDVI value is 

classified according to the NDVI range values (Kuzevic et 

al. 2022). 

Calculating land cover area/vegetation density 

Calculation of land cover area using the reclassify tool. 

Reclassification can be used to reclassify the variable's 

value on the raster gained value basis (Jebur et al. 2015). 

The NDVI results are in raster format on ArcMap, then 

were reclassified using ArcToolbox > Spatial Analyst 

Tools > Reclass. In reclassifying the raster, manual 

classification was according to the range of NDVI values, 

as presented in Table 2. After reclassifying, we convert the 

reclassified raster into polygons using the Conversion 

Tools > From Raster > Raster to Polygon tool. The 

converted polygon file will then limit the cover area 

according to the classification value in Table 2. Using the 

Start Editing command button, We merge all the polygons 

according to their respective grid codes in the data attribute 

table. After all the polygons are put together according to 

their respective grid codes, we create a new column (add 

field) in the data attribute table with Double type. Then, do 

Calculate Geometry on that column and determine the area 

unit to be used. Calculate Geometry is a tool that can 

calculate a polygon's coordinates, length, and area (Sobatnu 

et al. 2017). The area calculation results will appear in the 

column.  

Relationship between distance from mine and vegetation 

density 

The distance from the mine area and the vegetation 

density were correlated using a simple linear regression 

analysis in Microsoft Excel 2019. The distance is measured 

every 200 meters from the mine, especially on the west and 

north sides of the mining region. The analysis results are 

then given graphically in the form of a scatter plot, along 

with the coefficient of determination (R2) value, which 

indicates the level of the relationship. 

RESULTS AND DISCUSSION 

Land cover in 2001, 2015 and 2020 

The analysis results show that four land cover types are 

produced, i.e., non-vegetation, open soil, sparse vegetation, 

and moderate vegetation. Sparse vegetation is the widest 

land cover type, i.e., 19.893 km2 in 2001, 13.650 km2 in 

2015, and 11.358 km2 in 2020. Non-vegetation and open 

soil types have an area of 0.003 and 0.155 km2 in 2001, 

2.892 and 2.590 km2 in 2015, and 4.910 and 2.620 km2 in 

2020. Moderate vegetation cover type had an area of 0.287 

km2 in 2001, 1.206 km2 in 2015, and 1.450 km2 in 2020. 

The distribution pattern of land cover, area, and percentage 

in 2001, 2015, and 2020 has been presented in Figures 2 

and 3, Tables 3 and 4. 

Land cover area changes 

The non-vegetation and open soil cover increased 2.889 

and 2.435 km2 from 2001 to 2015 and 2.018 and 0.030 km2 

from 2015 to 2020. Sparse and moderate vegetation cover 

experienced different things, where sparse vegetation 

decreased by 6.243 in the 2001 period to 2015 and 2.292 

km2 in the period 2015 to 2020, while moderate vegetation 

increased by 0.919 km2 in the period 2001 to 2015 and 

0.244 km2 in the period 2015 to 2020. Data on changes in 

the land cover area have been presented in Table 5 and 

Figure 4. 

 

 
Table 2. NDVI value class 

 

No. Cover Type NDVI Value 

1 Non-Vegetation NDVI<0.1 

2 Open Soil 0.1<NDVI<0.2 

3 Sparse Vegetation 0.2<NDVI<0.4 

4 Moderate Vegetation 0.4<NDVI<0.6 

5 Dense Vegetation 0.6<NDVI<1 

 

 

 
Table 3. The area of each land cover 

 

Cover Type 
Cover Area (km2) 

2001 2015 2020 

Non-vegetation 0.003  2.892  4.910  

Open soil 0.155  2.590  2.620  

Sparse vegetation 19.893  13.650  11.358  

Moderate vegetation 0.287  1.206  1.450  

Dense vegetation 0 0 0 

Total 20.338 

 

 

 
Table 4. Percentage of each land cover area 

 

Cover Type 
Cover Percentage (%) 

2001 2015 2020 

Non-vegetation 0.01 14.22 24.14 

Open soil 0.76 12.73 12.88 

Sparse vegetation 97.81 67.12 55.85 

Moderate vegetation 1.41 5.93 7.13 

Dense vegetation 0 0 0 
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Figure 2. Map of land cover patterns in 2001, 2015 and 2020 

 

 
 

 
 

Figure 3. Comparison of land cover areas in 2001, 2015 and 2020 

 

 

 
Table 5. Changes in the land cover area in the 2001-2015 and 

2015-2020 periods 

 

Cover Type 
Period 

2001-2015 (km2) 2015-2020 (km2) 

Non-vegetation 2.889 2.018 

Open soil 2.435 0.030 

Sparse vegetation -6.243 -2.292 

Moderate vegetation 0.919 0.244 

Dense vegetation 0 0 

 

Discussion 

The land cover classification produces four types: non-

vegetation, open soil, sparse vegetation, and moderate 

vegetation. The results of measuring the area of land cover 

types in 2001, 2015, and 2020 produce different variations 

each year (Figure 4). In 2001, the land cover was 

dominated by sparse vegetation (97.81%) with an area of 

19.893 km2. Non-vegetation land cover types (0.01%), 

open soil (0.76%), and moderate vegetation (1.41%) have 

an area of 0.003, 0.155, and 0.287 km2, respectively. In 

2015, all land cover categories experienced changes in the 

area, where sparse vegetation (67.12%) was still dominant 

with an area of 13.650 km2, non-vegetation (14.22%) 

covering 2.888 km2, open soil (12.73%) covering 2.590 

km2 and moderate vegetation (5.93%) covering an area of 

1.206 km2. In 2020, sparse vegetation (55.85%) and non-

vegetation (24.14%) dominated with an area of 11.358 and 

4.910 km2, respectively. While another cover, such as open 

soil (12.88%), covers an area of 2.620 km2, and moderate 

vegetation (7.13%) covers an area of 1.450 km2. 

 

 
 

 
 
Figure 4. Changes in the land cover area in the 2001-2015 and 

2015-2020 periods 
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The land cover change analysis shows, in general, there 

has been an increase in the area of the mining area, which 

is assumed to be a non-vegetation area increasing. 

Meanwhile, sparsely vegetated areas continued to 

experience a significant decrease from 2001 to 2020. 

Sparsely vegetated areas decreased by 6.243 km2 from 

2001 to 2015 and 2.292 km2 from 2015 to 2020. Vegetation 

is experiencing a slight increase in area, namely 0.919 km2 

from 2001 to 2015 and 0.244 km2 from 2015 to 2020. 

Meanwhile, 2.889 km2 of non-vegetation increased from 

2001 to 2015, and an additional 2.018 km2 from 2015 to 

2020 due to the opening of mining land. The open soil area 

assumed to be a non-vegetated area also increased by 2.435 

km2 from 2001 to 2015 and a minor 0.030 km2 from 2015 

to 2020. This decrease in vegetation cover was due to the 

open-pit mining method applied in this area. The open-pit 

mining method damages the landscape and forests at the 

mining site because trees, plants, and topsoil are cleared 

from the area to be mined (Stracher, 2019). Reducing 

vegetation due to mining activities also occurs in the 

Sungun mine area in Iran, the Athabasca mine in Canada, 

and the Hambach mine in Germany. The Sungun mining area 

in Iran experienced a forest reduction of 4.05 km2 during the 

period 1989-2019, the Athabasca mine in Canada 

experienced a forest reduction of 9.05 km2 from 1999-

2019, and the forest at the Hambach mine in Germany 

decreased by 46.39 km2 during 1989-2017 (Firozjaei et al. 

2021). 

Based on the land cover map, mining areas are 

developing in the coastal areas of Tapunggaya and 

Tapuemea Villages. This development in the coastal area is 

thought to be caused by the influence of the availability of 

transportation infrastructure because the connecting road to 

the locations of Tapunggaya and Tapuemea Villages is 

along the coast. In addition, the availability of land roads 

greatly supports the development of the mining industry 

because it will be vital for logistics distribution (Zhang and 

Wu 2022; Zhang and Cheng 2023). 

Most mining areas in the study area are in the 

Mandiodo, Tapuemea, and Tapunggaya Village Molawe 

Sub-districts. This is thought to be caused by the 

distribution of nickel laterite deposits, which are more 

abundant in all three villages. Nickel laterite deposits in the 

Molawe Sub-district have different thicknesses at each 

point or area, with the highest thickness being in the central 

to eastern sides, namely 5-13 meters, while in the western 

sides, they only have a relatively lowest, namely 1-2 meters 

(Raivel and Hasrianto 2023). 

The effect of decreasing vegetation cover due to mining 

activities usually occurs around mined areas, while areas 

outside mining areas have relatively better vegetation 

cover. According to Pour et al. (2021), the direct and 

indirect effects of mining activities on the growth and 

health of plant vegetation generally decrease linearly, 

followed by increasing the distance of vegetation from the 

mine to at least 600 m. Research Fakhimi (2020) also 

suggests that increasing the distance of vegetation from the 

mining area can significantly increase the cover percentage 

for several plant species, including Asteraceae, Fabaceae, 

Poaceae, Chenopodiaceae, and Lamiaceae. The difference 

in vegetation cover affected by the distance of vegetation to 

the mine site is due to the relatively better soil quality in 

areas far from the mine. The soil near mining sites generally 

contains more contaminants due to the heavy metal residues 

released into the soil (Fashola et al. 2016). 

The correlation analysis results between the distance 

from the mine and the vegetation cover (Figure 5) at the 

study site show an R2 value of 0.052. This value indicates 

no linear relationship between the distance from the mine 

and the vegetation cover. This is due to the increasingly 

widespread conversion of forest functions around mines to 

other uses, such as residential areas and agriculture 

development. Based on Figures 6 and 7, the north side of 

AOI has been converted into plantation and agricultural 

development, while the east side is a mangrove forest that 

is starting to turn into an aquaculture area, and the west 

side is a forest area that has uneven coverage. Uneven 

forest cover on the western side of the AOI is caused by 

several factors, including the effects of mining, which 

reduces fertility will further inhibit vegetation growth 

(Prematuri et al. 2020) and differences between vegetation 

types, vegetation ages, and environmental conditions (Fang 

et al. 2014). 

The area on the north side of AOI, which is in the 

administrative area of Andowia sub-district, has mostly 

been converted into oil palm plantation land owned by PT. 

Sultra Prima Lestari (SPL) and community agricultural 

land. Agricultural development in rural areas is strongly 

tied to most rural communities that work as farmers (Moomen 

and Dewan 2015) and will heavily rely on the agricultural 

industry (Waddington et al. 2014). Aside from the 

agricultural sector, settlement is expanding around mining 

locations. The increasing need for residential areas for local 

communities and migrant workers from outside the area to 

support ease of access and proximity to workplaces is a 

driving force for residential development. According to 

Pratama et al. (2019), settlements that emerge in mining 

areas tend to develop relatively quickly due to the strong 

demand for residential areas and suitable services and 

infrastructure availability. Moreover, several mining 

companies in North Konawe have allocated their Corporate 

Social Responsibility (CSR) funds to develop several 

village infrastructures, educational and religious 

infrastructure (Kasmudin et al. 2018; Masri et al. 2019). 
 

 

 
 

Figure 5. The relationship between distance from the mine and 

image reflectance 
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Figure 6. Map of land cover around the area of interest (AOI) 

 

 

 

 
 

Figure 7. NDVI pattern based on distance from north and west mine side 

 

 

 

Forest degradation caused by mining activities in the 

Molawe Sub-district requires the Central and Regional 

Governments' attention to mitigate the significant impact in 

the future. Consider that the mining area in the Molawe 

Sub-district is mountainous, close to settlements, and 

borders Lasolo Bay. Landslides are a disaster that can be 

produced by mining in this area (Mu et al. 2021) because 

the soil is more unstable after extra mining activities in 

various North Konawe’s nickel mining locations (Barus et 

al. 2022). The presence of mines on the mainland directly 

impacts Lasolo Bay. In addition to water, mining can also 

pollute groundwater sources. Research by Ullah et al. 

(2022) reveals that groundwater sources in areas close to 

mining experience heavy metal contamination in the 

groundwater. This can impact the health of the people who 

live around it. Based on several examples of impacts that 

can occur as a result of mining, all stakeholders need to 

carry out management that is conserving and realizing 

environmental sustainability because preserving the 

environment of settlements in mining areas must be given 

attention to social, economic, environmental and policy 

(Sushanti et al. 2020). 
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